LIST Spatial Web Services

User Guide

This document demonstrates how LIST Web Services can be added to commonly used spatial applications (including ArcMap, ArcGIS Pro, ArcGIS Online, QGIS, MapInfo, OruxMaps, Map Plus, MotionX-GPS and AutoCAD Civil 3D)

LAST UPDATED January 2020
Table of Contents

LIST Spatial Web Services .................................................................................................................. 1
  What is the LIST? .......................................................................................................................... 1
  What are spatial web services? ..................................................................................................... 1
  LIST web services ....................................................................................................................... 1
  How to access LIST spatial web services .................................................................................. 2
  Why are there multiple LIST spatial web service protocols? ..................................................... 2
  ArcGIS server and supported protocols ....................................................................................... 2
    What is an ArcGIS server? ......................................................................................................... 2
    Supported protocols ................................................................................................................ 3
      REST ................................................................................................................................... 3
      WMTS (limited as not all services support WMTS) ............................................................... 3
      WMS .................................................................................................................................... 3
      WFS (limited as not all services support WFS) ..................................................................... 3

Licensing and usage .......................................................................................................................... 4
  Creative Commons Attribution Only .......................................................................................... 4
    What you can do ....................................................................................................................... 4
  Creative Commons Attribution, Non-Commercial and No Derivatives ...................................... 5
    What you can do ....................................................................................................................... 5
  Standard Government Copyright Statement ............................................................................. 5
  No visible license agreement ........................................................................................................ 6

Metadata ........................................................................................................................................... 6

LIST data .......................................................................................................................................... 6

Spatial reference systems ................................................................................................................ 6

Quick Info ......................................................................................................................................... 7
  Adding a basemap ........................................................................................................................ 7
  Adding services other than basemaps .......................................................................................... 7

How to get the correct web service URL ....................................................................................... 8
  URLs for ArcGIS server REST services .................................................................................... 8
Adding services in common GIS platforms

How to add services in ArcMap Version 10.6

Adding ArcGIS REST services to ArcMap
Adding WMTS services to ArcMap
Adding WMS services to ArcMap
Adding WFS services to ArcMap
Clear Display Cache in ArcMap

How to add services in ArcGIS Pro Version 2.4.0

Adding ArcGIS REST services to ArcGIS Pro
Adding WMTS services to ArcGIS Pro
Adding WMS services to ArcGIS Pro
Adding WFS services to ArcGIS Pro

How to add services in ArcGIS Online

Adding ArcGIS REST services to ArcGIS Online
Adding WMTS services to ArcGIS Online
Adding WMS services to ArcGIS Online
Adding WFS services to ArcGIS Online

How to add services in QGIS Version 3.2.0

Adding WMTS services to QGIS
Adding WMS services to QGIS
Adding WFS services to QGIS

How to add services in MapInfo Pro v2019

Adding REST tile services to MapInfo Pro
Adding the Topographic basemap
Adding the Orthophoto basemap
Adding the Topographic Gray Scale basemap
Adding the TASMAP basemap
Adding WMTS services to MapInfo Pro
Adding WMS services to MapInfo Pro ................................................................. 62
Adding WFS services to MapInfo Pro ................................................................. 65

Adding services in common GIS mobile applications ........................................... 69
How to add services in OruxMaps (mobile application for Android) ...................... 69
Adding REST tile services (basemaps) to OruxMaps ........................................... 69
Adding WMS services to OruxMaps .................................................................. 74
How to add services in Map Plus (mobile application for Apple iOS) .................... 82
Adding WMS services to Map Plus .................................................................. 82
How to add services in MotionX-GPS (mobile application for Apple iOS) ............ 87
Adding REST tile services (basemaps) to MotionX-GPS ..................................... 87
How to add services to AutoCAD Civil 3D 2015 ................................................. 89
Adding ArcGIS REST services to AutoCAD Civil 3D ....................................... 89
  Download and install AutoCAD service packs and ArcGIS for AutoCAD plugin 89
  Setting drawing limits prior to adding services .................................................. 89
  Adding ArcGIS REST services using ArcGIS for AutoCAD plugin .................. 90
Adding WMS services to AutoCAD Civil 3D ..................................................... 93
  Fix for dialog window display issue in AutoCAD Civil 3D 2015 ......................... 93
  Assigning a global coordinate system to your AutoCAD Drawing ................... 94
  Adding WMS services to AutoCAD Drawing .................................................. 97

References for spatial applications ................................................................. 100
Feedback and further support ................................................................. 100
  LIST Helpdesk .................................................................................................. 100

Department of Primary Industries, Parks, Water and Environment
LIST Spatial Web Services

What is the LIST?

The Land Information System Tasmania (the LIST) is a whole-of-government online infrastructure that helps you find and use information about land and property in Tasmania. The LIST can be accessed by visiting www.thelist.tas.gov.au/. The LIST is comprised of numerous components, which are briefly summarised below:

- The Properties and Titles search facility of the LIST enables you to find and obtain a range of property and title documents and information, including land titles, survey plans, government valuations, property reports and sales data.
- LISTmap is a free, easy to use, online map application that allows you to view, create and share your own customised maps of Tasmania.
- LISTdata is a free, easy to use online data portal that helps you discover, use and reuse a wide range of Tasmanian location-based information, and provides a central access point to connect to or download authoritative government data, including Open Data.
- LISTservices are free web service endpoint(s) that can be integrated into your business systems and applications via spatial web services.

What are spatial web services?

A web service is a software system which supports communication between one computer and another computer over a network. The LIST web services enable users to access and use authoritative spatial datasets from the Department of Primary Industries, Parks, Water and Environment (DPIPWE) in a variety of ways, through standard internet protocols.

This document details ways in which users can connect to the spatial web services using the most common GIS applications and tools.

LIST web services

- Allow users to access and use core authoritative spatial datasets while eliminating a lot of the management overhead for the provision, storing and maintenance of that data;
- Allow users to receive ongoing current and dynamic feeds of public and basemap data into their business system;
- Can be consumed in mobile applications;
- Can be used for development purposes; and
LIST Spatial Web Services

User Guide

- Can be used directly in numerous spatial systems or Geographical Information System (GIS) platforms, some of which are covered in this document.

How to access LIST spatial web services

LIST datasets can be accessed via the following web service portal:

- **ArcGIS** - delivering REST services, predominantly used by (but not limited to) Esri software. ArcGIS also provides Open Geospatial Consortium (OGC) compliant web services, supported by most spatial applications and systems. The LIST ArcGIS REST and OGC services can be accessed via the following URL:

  https://services.thelist.tas.gov.au/arcgis/rest

Why are there multiple LIST spatial web service protocols?

The **ArcGIS Server REST services** are not always accessible via non-Esri products so support for ‘Open Geospatial Consortium’ (OGC) compliant web services (such as WMTS, WMS or WFS) have also been enabled.

Additional information and links to these supported protocols can be found below.

ArcGIS server and supported protocols

The LIST **ArcGIS REST** services can be accessed via the following URL:

https://services.thelist.tas.gov.au/arcgis/rest

What is an ArcGIS server?

ArcGIS Server is the core server geographic information system (GIS) software made by Esri. ArcGIS Server is used for creating and managing GIS Web services, applications, and data. ArcGIS Server is typically deployed on-premises within the organization’s service-oriented architecture (SOA) or off-premises in a cloud computing environment.

Supported protocols

REST

Representational State Transfer (REST) is a software architecture style consisting of guidelines and best practices for creating scalable web services. REST is a coordinated set of constraints applied to the design of components in a distributed hypermedia system that can lead to a more performant and maintainable architecture. RESTful systems typically, but not always, communicate over the Hypertext Transfer Protocol with the same HTTP verbs (GET, POST, PUT, DELETE, etc.) used by web browsers to retrieve web pages and send data to remote servers.


WMTS (limited as not all services support WMTS)

A Web Map Tile Service (WMTS) is a standard protocol for serving pre-rendered or run-time computed georeferenced map tiles over the Internet. The specification was developed and first published by the Open Geospatial Consortium in 2010.


As WMTS provides better performance for the end user, it is recommended to use WMTS over WMS if available.

WMS

A Web Map Service (WMS) is a standard protocol developed by the Open Geospatial Consortium in 1999 for serving georeferenced map images over the Internet.[1] These images are typically produced by a map server from data provided by a GIS database.


WFS (limited as not all services support WFS)

The Open Geospatial Consortium Web Feature Service Interface Standard (WFS) provides an interface allowing requests for geographical features across the web using platform-independent calls. One can think of geographical features as the ‘source code’ behind a map, whereas the WMS interface or online tiled mapping portals like Google Maps return only an image, which end-users cannot edit or spatially analyze.

Licensing and usage

All LIST data is subject to copyright, and a range of license conditions also govern the use of the data. These licensing conditions must be adhered to when using LIST web services. Before accessing the LIST web services, please read the LIST Web Services Terms and Conditions (https://listdata.thelist.tas.gov.au/public/LISTWebServicesTermsConditions.pdf).

The license that applies to a particular dataset is identified at the Service and Layer levels of LIST web services, under Copyright Text.

![ArcGIS REST Services Directory](image)

**Note:** It is important to check the Copyright Text for both the Service and the Layer, as the multiple layers within a service may have different license conditions.

**Creative Commons Attribution Only**

![Creative Commons Logo](image)

**What you can do**

Under ‘Creative Common Attribution Only’ you are free to:

- Share - copy and redistribute the material in any medium or format;
- Adapt - remix, transform, and build upon the material for any purpose, even commercially.

The licensor cannot revoke these freedoms as long as you follow the license terms, being:

- Attribution - you must give appropriate credit, provide a link to the license, and indicate if changes were made. You may do so in any reasonable manner, but not in any way that suggests the licensor endorses you or your use;
• No additional restrictions - you may not apply legal terms or technological measures that legally restrict others from doing anything the license permits.

Please see https://creativecommons.org/licenses/by/3.0/au/ for full details.

Creative Commons Attribution, Non-Commercial and No Derivatives

What you can do

Under ‘Creative Commons Attribution, Non-Commercial and No Derivatives' you are free to:

• Share - copy and redistribute the material in any medium or format.

The licensor cannot revoke these freedoms as long as you follow the license terms, being:

• Attribution - you must give appropriate credit, provide a link to the license, and indicate if changes were made. You may do so in any reasonable manner, but not in any way that suggests the licensor endorses you or your use;
• Non-Commercial - you may not use the material for commercial purposes;
• No Derivatives - if you remix, transform, or build upon the material, you may not distribute the modified material;
• No additional restrictions - you may not apply legal terms or technological measures that legally restrict others from doing anything the license permits.

Please see https://creativecommons.org/licenses/by-nc-nd/3.0/au/ for full details.

Standard Government Copyright Statement

Where the standard LIST copyright text appears (see below), the Data is subject to Crown Copyright provisions as defined by the Copyright Act 1968. The Data is to be used internally within your organisation to support the execution of your usual business activities.

Copyright Text: the LIST State of Tasmania

However, if the Data will be incorporated into another product, distributed or on-sold in any way, you must contact LIST Help Desk on (03) 6165 4444, or via email listhelp@dpipwe.tas.gov.au, to obtain permission before use. Please note that a fee may be applicable.
No visible license agreement

Where there is no Copyright Text visible for a particular dataset, you must assume that Creative Commons does not apply, and the dataset is not available for free under Open Data. Please contact the LIST Help Desk on (03) 6165 4444, or via email listhelp@dpipwe.tas.gov.au, to clarify licensing before usage.

Metadata

LIST datasets have detailed metadata records that provide further information about the datasets. You can access these via LISTdata: LISTdata (data.thelist.tas.gov.au)

LISTdata

LISTdata is a free, easy to use online data portal that helps you discover, use and reuse a wide range of Tasmanian location-based information, and provides a central access point to connect to or download authoritative government data, including LIST OpenData (listdata.thelist.tas.gov.au/opendata/).

Spatial reference systems

The following is a list of the supported spatial reference systems (SRS) for the LIST web services:

- **EPSG:3857** – WGS84 Web Mercator (Auxiliary Sphere) – default SRS for all of the LIST’s spatial web services.
- **EPSG:4326** – WGS84 Longitude-Latitude.
- **EPSG:102100** – ESRI’s Web Mercator.
- **EPSG:28355** – GDA94 / MGA Zone 55.
- **EPSG:4283** – GDA94 Longitude-Latitude.
Quick Info

The LIST ArcGIS REST services can be accessed via the following URL:

https://services.thelist.tas.gov.au/arcgis/rest

Adding a basemap

The most common initial task in spatial applications is to load a context map or basemap, a variety of which are supplied via the LIST REST Web Service:

https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps

Where possible, and if the application supports, use the REST service for optimal performance. The next best option is WMTS, then WMS followed by WFS.

Refer to sections titled Adding REST Services/WMTS/WMS/WFS for detailed information on enabling basemaps in common GIS applications.

Adding services other than basemaps

For optimal performance for vector-based datasets use the REST services where possible. The next best option is WMS, followed by WFS.

Refer to sections titled Adding REST Services/WMTS/WMS/WFS for detailed information on enabling non-basemap datasets in common GIS applications.
How to get the correct web service URL

**URLs for ArcGIS server REST services**

- In a web browser, enter the following URL: https://services.thelist.tas.gov.au/arcgis/rest. This URL is often all that is required for many applications that support ArcGIS server REST services. Entering this basic URL will give access to all the folders and services contained within via the applications navigation pane.

- To enter specific REST end points, drill down through the folders and services then copy the URL found in the web browsers address bar.

- A basemap URL will look like the following:
• A non-basemap service URL containing numerous layers will look like this:

![Image of service URL](image1)

• An individual layer or REST end point URL will look like the following:

![Image of service URL](image2)

### URLs for ArcGIS server WMS, WMTS or WFS services

• The majority of services have WMS capabilities, but only certain services have WMTS capabilities under [https://services.thelist.tas.gov.au/arcgis/rest](https://services.thelist.tas.gov.au/arcgis/rest). WFS is available via one service: [https://services.thelist.tas.gov.au/arcgis/rest/services/Public/OpenDataWFS/MapServer](https://services.thelist.tas.gov.au/arcgis/rest/services/Public/OpenDataWFS/MapServer). To see which service has either WMS or WMTS enabled, drill down to the service level and look for either WMTS, WMS or WFS in the top left-hand corner of the page.

• If they are enabled, click on the links.

• For **WMTS** copy the URL up to and including the first WMTS, for example:
• For **WMS** copy the URL up to and including WMSServer, for example:

![WMS XML example](image1)

- For **WFS** copy the URL up to and including WFSServer, for example:

![WFS XML example](image2)
Adding services in common GIS platforms

The following instructions are provided as a guide only. For more detailed instructions please refer to the vendor’s online help or click on the reference links found under References for spatial applications at the end of this document.

How to add services in ArcMap Version 10.6

Adding ArcGIS REST services to ArcMap

Note: Please refer to Clear Display Cache in ArcMap before adding a LIST basemap.

- Within ArcMap, if the catalog pane is not already open, click on the open Catalog button or click on the Windows menu and select Catalog to view the pane.

- In your Catalog pane expand GIS Servers then click on Add ArcGIS Server.
• Select **Use GIS services** then click **Next**.

![Add ArcGIS Server dialog]

• In the **Server URL** box type in the following URL
  
  https://services.thelist.tas.gov.au/arcgis/rest/

  leave the **User Name** and **Password** blank then click **Finish**.

![ArcGIS Server connection settings]
• Expand the folders to see the available services and click and drag the service into your mxd (or ArcMap document) to load all the layers for that service.

Adding WMTS services to ArcMap

• For the best performance with Esri software, it is recommended to add WMTS services as ArcGIS REST services as outlined in Adding ArcGIS REST Services to ArcMap.
• WMTS is only available on some of the LIST basemap services found under https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps.
• Refer to https://services.thelist.tas.gov.au/arcgis/rest/ to see what services have WMTS enabled (look for WMTS link in the top left corner).
To add a WMTS layer to ArcMap:

- Within ArcMap, if the catalog pane is not already open, click on the open **Catalog** button or click on the **Windows** menu and select **Catalog** to view the pane.

- In your Catalog pane expand **GIS Servers** then click on **Add WMTS Server**.

- In the **URL** text box, type in a valid URL such as https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/MapServer/WMTS
• Click **Get Layers** to make sure the URL is valid, and if it is, click **OK** to add the service to the catalog pane.

![Add WMTS Server](image1)

• Expand the folders to see the available services and click and drag the layer to add it to your mxd (or ArcMap document).

![Catalog](image2)
Adding WMS services to ArcMap

- For the best performance with Esri software, it is recommended to add WMS services as ArcGIS REST services as outlined in Adding ArcGIS REST Services to ArcMap.
- WMS is available for most (but not all) of the LIST services found under https://services.thelist.tas.gov.au/arcgis/rest/services.
- Look for WMS in the top left corner to see which services have WMS enabled.

<table>
<thead>
<tr>
<th>ArcGIS REST Services Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home &gt; services &gt; Basemaps &gt; Topographic (MapServer)</td>
</tr>
<tr>
<td>EION</td>
</tr>
</tbody>
</table>

- Within ArcMap, if the catalog pane is not already open, click on the open Catalog button or click on the Windows menu and select Catalog to view the pane.

- In your Catalog pane expand GIS Servers then click on Add WMS Server.
• Type the URL of the desired WMS service into the **URL** box, then click **Get Layers** to see what layers are available and then click the **OK** button.

For example, the following URL (including the final “?” character):  
https://services.thelist.tas.gov.au/arccis/services/Public/TopographyAndRelief/MapServer/WMSServer?

will add layers from the TopographyAndRelief service.

• Expand the folders to see the available services and click and drag the layer to add it to your mxd (or ArcMap document).
Adding WFS services to ArcMap

- For the best performance with Esri software, it is recommended to add WMS services as ArcGIS REST services as outlined in Adding ArcGIS REST Services to ArcMap.
- WFS is only available from LIST via the following URL: https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer/WFSServer.

To add a WFS layer to ArcMap:

- The ArcGIS Interoperability Extension for Desktop must be installed (but doesn’t need to be enabled). To check if you have this extension installed, from within your ArcMap document, click on the Customize menu option then the Extensions... menu option.

- If the extension has been installed, there will be a Data Interoperability option in the list of extensions. It does not need to be enabled to proceed but it does have to be in the list of extensions.
• Within ArcMap, if the catalog pane is not already open, click on the open Catalog button or click on the Windows menu and select Catalog to view the pane.

![Catalog pane](image)

• In your Catalog pane expand Interoperability Connections then click on Add Interoperability Connection.

![Add Interoperability Connection](image)

• Select WFS (Web Feature Service) from the drop-down list next to Format:, then click on the Parameters… button.

![Interoperability Connection](image)

• Type the following into the URL box: https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer/WFSServer, then select WFS Version = 2.0.0, click the three dots button next to Feature Types to select the check box(es) next to the desired layer(s), and under the GML SRS/Geometry Parameters drop-down menu, select SML SRS Axis Order = 2,1
(Please be aware that this service has a 2,000 maximum feature limit on each layer for performance requirements. To see more than the first 2,000 records, an XML Filter Expression needs to be included, however, formatting such a request is not covered in this document.).

- After selecting the desired layer or layers, click **OK** on all the open windows.
- Expand the new connection in ArcCatalog and click and drag the layer to add it to your mxd (or ArcMap document).

![Add Interoperability Connection](image1.png)

**Clear Display Cache in ArcMap**

When regularly using the LIST basemaps ([https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps](https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps)) it is good practice to clear the ArcMap display cache as it may mask any updates carried out on those basemaps.

- Within ArcMap, remove any basemaps from the document then click on the **Customize** menu option, then click on **ArcMap Options**.
- Click on the **Display Cache** tab and then click on **Clear Cache**. This may take some time if the display cache is large. Click **OK** to dismiss the window when the cache has been cleared.

![Clear Cache](image2.png)

- The cache options for any added basemap can also be altered by right clicking on the basemap within the ArcMap document and clicking on **Properties**.
• Within the **Properties** dialog window, click on the **Cache** tab and select the desired caching option, then click **OK** to apply those settings.

![Layer Properties dialog](image1)

How to add services in ArcGIS Pro Version 2.4.0

**Adding ArcGIS REST services to ArcGIS Pro**

• To add an ArcGIS Server connection to your ArcGIS Pro project, select the **INSERT** tab and click on the **Connections** drop-down list, then select **New ArcGIS Server**.

![Insert tab](image2)
• Enter [https://services.thelist.tas.gov.au/arcgis/rest/services](https://services.thelist.tas.gov.au/arcgis/rest/services) as the **Server URL** and click **OK**.

![Add ArcGIS Server Connection](image1.png)

• Under the **Project** pane, expand the **Servers** folder then the recently created LIST REST server.

![ArcGIS Pro](image2.png)
To add a service, simply right click on. Select Add To New > Map if a map did not already exist in the project, otherwise select Add To Current Map. Please be aware that you may need to zoom into the extent of Tasmania before the data is visible.

Adding WMTS services to ArcGIS Pro

- For the best performance with Esri software, it is recommended to add WMTS services as ArcGIS REST services as outlined in Adding ArcGIS REST Services to ArcGIS Pro.
- WMTS is only available on some of the LIST basemap services found under https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps.
- Refer to https://services.thelist.tas.gov.au/arcgis/rest/ to see what services have WMTS enabled (look for WMTS link in the top left corner).

To add a WMTS layer to ArcGIS Pro:
- On the Insert tab, click on Connections and click on New WMTS Server.
• In the **Server URL** text box, type in a valid URL such as
  https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/MapServer/WMTS
• Drag-and-drop the layer into the **Contents** pane or right-click and choose **Add To Current Map**.

![Image of drag-and-drop layer into Contents pane](image.png)

### Adding WMS services to ArcGIS Pro

• For the best performance with Esri software, it is recommended to add WMS services as ArcGIS REST services as outlined in [Adding ArcGIS REST Services to ArcGIS Pro](#).

• WMS is available for most (but not all) of the LIST services found under [https://services.thelist.tas.gov.au/arcgis/rest/services](https://services.thelist.tas.gov.au/arcgis/rest/services).

• Look for WMS in the top left corner to see which services have WMS enabled.
To add a WMS layer to ArcGIS Pro:

- On the **Insert** tab, click on **Connections** and click on **New WMS Server**.

- Type the URL of the desired WMS service into the **Server URL** box, then click the **OK** button.

  For example, the following URL (including the final “?” character):
  
  https://services.thelist.tas.gov.au/arCGIS/services/Public/TopographyAndRelief/MapServer/WMSServer?

  will add layers from the TopographyAndRelief service.
• Drag-and-drop the layer into the **Contents** pane or right-click and choose **Add To Current Map**.

![Image of ArcGIS interface with layer in Contents pane](image)

**Adding WFS services to ArcGIS Pro**

• For the best performance with Esri software, it is recommended to add WMS services as ArcGIS REST services as outlined in [Adding ArcGIS REST Services to ArcMap](#).

• WFS is **only** available from LIST via the following URL:
  
  **[https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer/WFSServer](https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer/WFSServer)**.
To add a WFS layer to ArcGIS Pro:

- On the **Insert** tab, click on **Connections** and click on **New WFS Server**.

- Type the following into the **Server URL** box:
  ```
  ```
• Drag-and-drop the layer into the Contents pane or right-click and choose Add To Current Map.

• Double-click, or right-click and select Properties, on the newly added WFS layer in the Contents pane to open the Layer Properties window.
• Select **WFS** from the left-hand menu pane and **check the Swap x/y coordinates box** and click **OK**.

**How to add services in ArcGIS Online**

**Adding ArcGIS REST services to ArcGIS Online**

• Open ArcGIS Online within your preferred internet browser via the following URL:  
  [https://www.arcgis.com/home/webmap/viewer.html](https://www.arcgis.com/home/webmap/viewer.html).

• Click on **Modify Map** in the top right-hand corner.
• Then click on **Add – Add Layer from Web**.

![Add Layer from Web](https://example.com/)

• Select **An ArcGIS Server Web Service** from the drop-down list.

![Select ArcGIS Server Web Service](https://example.com/)

• Then type in your desired LIST ArcGIS REST Service found under [https://services.thelist.tas.gov.au/arcgis/rest](https://services.thelist.tas.gov.au/arcgis/rest) such as [https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Topographic/MapServer](https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Topographic/MapServer). In this example, we are using the Topographic LIST basemap, so it is possible to replace the default ESRI basemap by selecting **Use as Basemap** then click **Add Layer**.

![Add Layer from Web](https://example.com/)
With ArcGIS Online, you can either add an entire service that contains multiple layers or just an individual layer. For example, type in the following URL for an individual layer
https://services.thelist.tas.gov.au/arcgis/rest/services/Public/CadastreAndAdministrative/MapServer/4 or this URL for every layer in the service
https://services.thelist.tas.gov.au/arcgis/rest/services/Public/CadastreAndAdministrative/MapServer.

If a layer is grey in the contents area, you may need to zoom further in to see it on the map.

Adding WMTS services to ArcGIS Online

For the best performance with Esri software, it is recommended to add WMTS services as ArcGIS REST services as outlined in Adding ArcGIS REST Services to ArcGIS Online.

WMTS is only available on some of the LIST basemap services found under https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps.
• Refer to [https://services.thelist.tas.gov.au/arcgis/rest/](https://services.thelist.tas.gov.au/arcgis/rest/) to see what services have WMTS enabled (look for WMTS link in the top left corner).

<table>
<thead>
<tr>
<th>ArcGIS REST Services Directory</th>
</tr>
</thead>
<tbody>
<tr>
<td>Home &gt; services &gt; Basemaps &gt; Topographic (MapServer)</td>
</tr>
<tr>
<td>JSON</td>
</tr>
</tbody>
</table>

To add a WMTS layer to ArcGIS Online:
• Open ArcGIS Online within your preferred internet browser via the following URL: [https://www.arcgis.com/home/webmap/viewer.html](https://www.arcgis.com/home/webmap/viewer.html).
• Click on **Modify Map** in the top right-hand corner.
• Then click on Add and Add Layer from Web.

![Add Layer from Web](image)

• Select A WMTS OGC Web Service from the drop-down list and type in a valid WMTS URL, for example:
  
  https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/MapServer/WMTS.

![Add Layer from Web](image)

Adding WMS services to ArcGIS Online

• For the best performance with Esri software, it is recommended to add WMS services as ArcGIS REST services as outlined in Adding ArcGIS REST Services to ArcGIS Online.

• WMS is available for most (but not all) of the LIST services found under https://services.thelist.tas.gov.au/arcgis/rest/services.

• Look for WMS in the top left corner to see which services have WMS enabled.
• Open ArcGIS Online within your preferred internet browser via the following URL: https://www.arcgis.com/home/webmap/viewer.html.

• Click on Modify Map in the top right-hand corner.

• Then click on Add and Add Layer from Web.

• Select A WMS OGC Web Service from the drop-down list, type the URL of the desired WMS service into the URL box, then click the Add Layer button.
  For example, the following URL (including the final “?” character):
  https://services.thelist.tas.gov.au/arcgis/services/Public/TopographyAndRelief/MapServer/WMSServer?
  will add layers from the TopographyAndRelief service.
  (Note that the Get Layers option only becomes available after the first part of the URL, e.g.
https://services.thelist.tas.gov.au/arcgis/services/Public/TopographyAndRelief/MapServer has been entered, so you need to type/paste this first, and then add /WMSServer? to complete the URL to activate the Get Layers option).

- If a layer is grey in the contents area, you may need to zoom further in to see it on the map.

**Adding WFS services to ArcGIS Online**

**IMPORTANT NOTE:** At time of writing this guide, a software bug (Esri Case #02449458) has been detected in ArcGIS Online which impacts the functionality of LISTmap WFS layers. Although the layers may be added to a map by following the steps below, the data does not load, and as a result the features are effectively NOT available.

- For the best performance with Esri software, it is recommended to add WMS services as ArcGIS REST services as outlined in [Adding ArcGIS REST Services to ArcMap](#).
- WFS is **only** available from LIST via the following URL:
  
To add a WFS layer to ArcGIS Online:

- Open ArcGIS Online within your preferred internet browser via the following URL: [https://www.arcgis.com/home/webmap/viewer.html](https://www.arcgis.com/home/webmap/viewer.html).
- Click on **Modify Map** in the top right-hand corner.
- Then click on **Add** and **Add Layer from Web**.
- Select **A WFS OGC Web Service** from the drop-down list, type the following WFS URL [https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer/WFSServer?](https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer/WFSServer?) into the **URL** box, then click the **Get Layers** button.
  (Note that the **Get Layers** option only becomes available after the first part of the URL, e.g. [https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer](https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer))
has been entered, so you need to type/paste this first, and then add `/WFSServer` to complete the URL to activate the Get Layers option).

- **Select the Layer** you wish to add and then select Show Advanced Options.

- **Select the swap X/Y coordinates** checkbox and click Add Layer. Note: If you fail to do this your WFS layer may appear in an unexpected location (e.g. Tasmanian point may appear in/near Greenland in the Northern hemisphere).
• If a layer is grey in the contents area, you may need to zoom further in to see it on the map.

![Map screenshot showing grey layer]

How to add services in QGIS Version 3.2.0

Adding WMTS services to QGIS

• WMTS is the recommended format for basemap services for non-Esri software.
• WMTS is only available on some of the LIST basemap services found under https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps.
• Refer to https://services.thelist.tas.gov.au/arcgis/rest/ to see what services have WMTS enabled (look for WMTS in the top left corner).

To add a WMTS layer to QGIS:

• CTRL+SHIFT+W to Add WMS/WMTS Layer.
• Alternatively go to the Layer menu, select Add Layer, then Add WMS/WMTS Layer.

• For a new connection click on the New button.
Type in a meaningful name in the **Name** text box then type in a URL from the LIST's **ArcGIS REST web services** that has WMTS enabled, for example, https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Topographic/MapServer/WMTS/1.0.0/WMTSCapabilities.xml and then click **OK**.
Then click on the **Connect** button to view the available tile sets.
• Highlight a tile set that you wish to use and click **Add**.
• The results are then loaded into QGIS. Please be aware that the initial extent may not be initially zoomed in to Tasmania.

![QGIS map of Tasmania](image)

• For the best outputs you should set the scale of the map to one of the following.

<table>
<thead>
<tr>
<th>Level</th>
<th>Scale</th>
</tr>
</thead>
<tbody>
<tr>
<td>7</td>
<td>1:4,622,324</td>
</tr>
<tr>
<td>8</td>
<td>1:2,311,162</td>
</tr>
<tr>
<td>9</td>
<td>1:1,155,581</td>
</tr>
<tr>
<td>10</td>
<td>1:577,790</td>
</tr>
<tr>
<td>11</td>
<td>1:288,895</td>
</tr>
<tr>
<td>12</td>
<td>1:144,447</td>
</tr>
<tr>
<td>13</td>
<td>1:72,223</td>
</tr>
<tr>
<td>14</td>
<td>1:36,111</td>
</tr>
<tr>
<td>15</td>
<td>1:18,055</td>
</tr>
<tr>
<td>16</td>
<td>1:9,027</td>
</tr>
<tr>
<td>17</td>
<td>1:4,513</td>
</tr>
<tr>
<td>18</td>
<td>1:2,256</td>
</tr>
</tbody>
</table>
• If you are regularly using LIST maps then you can add these to your predefined scales using Settings, Options, Map Tools.

Adding WMS services to QGIS

• WMS is available for most (but not all) of the LIST services found under https://services.thelist.tas.gov.au/arcgis/rest/services.

• Look for WMS in the top left corner to see which services have WMS enabled.

To add a WMS layer to QGIS:

• CTRL+SHIFT+W to Add WMS/WMTS Layer.
• Alternatively go to the Layer menu, select Add Layer, then Add WMS/WMTS Layer.

• For a new connection click on the New button.
- Type a meaningful name in the **Name** text box then type in the URL for the desired WMS layers:
  
  ```
  https://services.thelist.tas.gov.au/arcgis/services/Public/TopographyAndRelief/MapServer/WMSServer?request=GetCapabilities&service=WMS
  ```

  and click **OK**.
• Ensure that you have the correct connection selected from the drop-down list then click on the **Connect** button to view the available layers then click on the Topography and Relief Id as shown below and then select **Add** to add the service into the map window.
- Highlight a layer, change the coordinate system if required, ensure that PNG is the Image encoding (if you want to overlay the features on other base maps) and click **Add** to add the layer to the map. This window will stay open if you want to add more layers or simply click the **Close** button to dismiss the window.
• Note: some layers do not appear until you zoom in.
• Once you have set up the WMS connection you can also drag and drop layers onto the map from the browser panel.

Adding WFS services to QGIS

• WFS is only available from LIST via the following URL:
To add a WFS layer to QGIS:
• CTRL+L to open the data source manager and click on the Add WFS as shown in the image below.
• Alternatively go to the **Layer** menu, select **Add Layer**.

• then **Add WFS**.
• For a new connection click on the **New** button.

![New button](image)

• Type a meaningful name in the **Name** text box then type in the following URL: https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer/WFSServer?request=GetCapabilities&service=WFS and click **OK**.

![Connection details](image)
• Ensure that you have the correct connection selected from the drop-down list, then click on the **Connect** button to view the available layers, highlight a layer, double click on it to add a filter expression if required, enable **Use title for layer name** and click **Add** to add the layer to the map. This window will stay open if you want to add more layers or simply click the **Close** button to dismiss the window. Please note that there is a 2,000 maximum feature limit on each layer for performance requirements for the LIST WFS service (https://services.thelist.tas.gov.au/arcgis/rest/services/Public/OpenDataWFS/MapServer).

How to add services in MapInfo Pro v2019

Adding REST tile services to MapInfo Pro

MapInfo Pro does not directly support REST tile services but if you follow the steps below, it can be added indirectly. Please note that **this is the best way to access the LIST basemaps in MapInfo Pro** as it offers better performance than simply accessing the WMS service for the same basemaps. Any error messages can be mitigated by zooming into the extent of Tasmania or preloading a layer into MapInfo Pro.
Adding the Topographic basemap

- In a text editor such as Notepad or Notepad++ type in the following lines:

```xml
<?xml version="1.0" encoding="utf-8"?>
<TileServerInfo Type="LevelRowColumn">
<Url>https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Topographic/MapServer/tile/{LEVEL}/{COL}/{ROW}?.png</Url>
<MinLevel>3</MinLevel>
<MaxLevel>18</MaxLevel>
<TileSize Height="256" />
<AttributionText Font="Font ("&quot;Tahoma&quot;,257,8,16777215,0)"">the LIST © State of Tasmania</AttributionText>
</TileServerInfo>
```

- Save the above file as `ListTopoBasemap.xml`. Alternatively, download the file from [https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo](https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo).

- Then in a new blank document, type in the following text:

```plaintext
!table
!version 1050
!charset WindowsLatin1

Definition Table
File "ListTopoBasemap.xml"
Type "TILESERVER"
CoordSys Earth Projection 10, 157, "m", 0 Bounds (-20037508.3428, -20037508.343) (20037508.3428, 20037508.343)
ReadOnly
```

- Save the above file as `ListTopoBasemap.TAB` in the same location as `ListTopoBasemap.xml`. Alternatively, download the file from [https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo](https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo).
To view the REST tile service in MapInfo Pro, click on the **Open** button then on the **Table** button and navigate to where you saved the .xml and .TAB files.

To avoid drawing errors and decrease waiting time for the data to load, pre-load another layer and zoom into a section of it.
Adding the Orthophoto basemap

- In a text editor such as Notepad or Notepad++ type in the following lines:

```xml
<?xml version="1.0" encoding="utf-8"?>
<TileServerInfo Type="LevelRowColumn">

<Url>https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/MapServer/tile/{LEVEL}/{COL}/{ROW}?.png</Url>
<MinLevel>6</MinLevel>
<MaxLevel>19</MaxLevel>
<TileSize Height="256" />
<AttributionText Font="Font ("Tahoma",257,8,16777215,0)">the LIST © State of Tasmania</AttributionText>
</TileServerInfo>
```

- Save the above file as ListOrthoBasemap.xml. Alternatively, download the file from https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo.

- Then in a new blank document, type in the following text:

```
!table
!version 1050
!charset WindowsLatin1

Definition Table
File "ListOrthoBasemap.xml"
Type "TILESERVER"
CoordSys Earth Projection 10, 157, "m", 0 Bounds (-20037508.3428, -20037508.343) (20037508.3428, 20037508.343)
ReadOnly
```

- Save the above file as ListOrthoBasemap.TAB in the same location as ListOrthoBasemap.xml. Alternatively, download the file from https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo.

- Add the orthophoto basemap by following the same steps as outlined in the screenshots in the Adding the Topographic basemap section above.

Adding the Topographic Gray Scale basemap

- For the Topographic Gray Scale basemap, follow the steps above but create the following files first:
Save the above file as **ListTopoGrayBasemap.xml**. Alternatively, download the file from [https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo](https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo).

Save the above file as **ListTopoGrayBasemap.TAB** in the same location as **ListTopoGrayBasemap.xml**. Alternatively, download the file from [https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo](https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo).

Add the orthophoto basemap by following the same steps as outlined in the screenshots in the **Adding the Topographic basemap** section above.
Adding the TASMAP basemap

- For the scanned **TASMAP basemap**, follow the steps above but create the following files first:

```xml
<?xml version="1.0" encoding="utf-8"?>
<TileServerInfo Type="LevelRowColumn">

<Url>https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/TasmastmapRaster/MapServer/tile/{LEVEL}/{COL}/{ROW}?.png</Url>
<MinLevel>6</MinLevel>
<MaxLevel>16</MaxLevel>
<TileSize Height="256" />
<AttributionText Font="Font ("Tahoma", 257, 8, 16777215, 0)"">the LIST &© State of Tasmania</AttributionText>
</TileServerInfo>
```

- Save the above file as **ListScannedTASMAPbasemap.xml**. Alternatively, download the file from [https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo](https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo).

- Save the above file as **ListScannedTASMAPbasemap.TAB** in the same location as **ListScannedTASMAPbasemap.xml**. Alternatively, download the file from [https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo](https://github.com/DPIPWE/list-spatial-web-service-examples/tree/master/MapInfo).

- Add the orthophoto basemap by following the same steps as outlined in the screenshots in the **Adding the Topographic basemap** section above.

Adding WMTS services to MapInfo Pro

- WMTS is the recommended format for basemap services for non-Esri software.
• WMTS is only available on some of the LIST basemap services found under https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps

• Refer to https://services.thelist.tas.gov.au/arcgis/rest/ to see what services have WMTS enabled (look for WMTS in the top left corner).

To add a WMTS layer to MapInfo Pro:

• After opening MapInfo Pro, on the HOME tab, click on Open and select Mapping (WMTS) under Web Services.

• Click on the Servers button.
• Then click on Add… to create a new connection to LIST Web services.

• Type the following into the Server URL:
  https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/MapServer/WMTS

• Add a meaningful Description, then click the Test URL button to see if you can connect.

• A working valid connection will return a window similar to the one below. Click Close to dismiss the window.

• Then click OK to create the connection.
• Next, select the server and click **OK**.

![WMTS Servers List](image)

• Then select the layer and click **OK** to add the layer to the map.

![Open WMST Table](image)

---

**Adding WMS services to MapInfo Pro**

• WMS is available for most (but not all) of the LIST services found under [https://services.thelist.tas.gov.au/arcgis/rest/services](https://services.thelist.tas.gov.au/arcgis/rest/services).

• Look for WMS in the top left corner to see which services have WMS enabled.
To add a WMS layer to MapInfo Pro:

- After opening MapInfo Pro, on the HOME tab, click on Open and select Mapping (WMS) under Web Services.

- Click on the Servers button.
• Then click on Add… to create a new connection to LIST Web services.

• Type the following into the Server URL:
  https://services.thelist.tas.gov.au/arcgis/services/Public/TopographyAndRelief/MapServer/WMSServer

• Add a meaningful Description, then click the Test URL button to see if you can connect. For example, the above URL will also allow you to add the layers from the TopographyAndRelief service.

• A working valid connection will return a window similar to the one below. Click Close to dismiss the window.
• Then **Double-click** or **Add** the layers you wish to add from the WMS Layers window and click **OK** to create the connection.

![Open WMS Table](image)

• Note that you may need to zoom in to see the layers.

**Adding WFS services to MapInfo Pro**

• **WFS is only** available from LIST via the following URL:
  
  https://services.thelist.tas.gov.au/arCGis/services/Public/OpenDataWFS/MapServer/WFSServer.
To add a WMS layer to MapInfo Pro:

- After opening MapInfo Pro, on the HOME tab, click on Open and select Mapping (WMS) under Web Services.

- Click on the Servers button.
• Then click on Add… to create a new connection to LIST Web services.

![Add button and list of services]

• Type the following into the Server URL: https://services.thelist.tas.gov.au/arcgis/services/Public/OpenDataWFS/MapServer/WFSServer
and add a meaningful Description, then click the Test URL button to see if you can connect.

![Server URL and Test URL dialog]

• A working valid connection will return a window similar to the one below. Click Close to dismiss the window.

![WFS Server Details window]

• Then click OK to create the connection.
• Select the **WFS Server** from the drop-down list and the **WFS Layer** you wish to access and click **OK**. Note that you may use the **Data Filters** options to customise the data being accessed as well as the **Object Styles** to change the symbology. Also note that there is a 2,000 maximum feature limit on each layer for performance requirements for the LIST WFS service ([https://services.thelist.tas.gov.au/arcgis/rest/services/Public/OpenDataWFS/MapServer](https://services.thelist.tas.gov.au/arcgis/rest/services/Public/OpenDataWFS/MapServer)).
Adding services in common GIS mobile applications

NOTE: This section is included to provide users with examples of adding WMS services to GIS mobile applications. It is not an endorsement of any specific GIS mobile application. Users should undertake their own testing and assessment to determine the GIS mobile application that best meets their needs.

How to add services in OruxMaps (mobile application for Android)

Adding REST tile services (basemaps) to OruxMaps

- After installing the OruxMaps application on your Android mobile device, connect the mobile device to a computer and navigate to …oruxmaps\mapfiles. To find the exact location, first open the OruxMaps application on your device, then click the Maps button in the top right, then Map settings. The exact location can be found under the Maps directory section.

- Copy the file called onlinemapsources.xml to your computer, and then open that file using a text editor such as notepad++ or notepad.

- Scroll down to the bottom of the file and insert the following text after the last </onlinemapsource> tag and before the last line with the tag </onlinemapsource>. Be sure to include all the text below, noting that it continues over two pages.

```xml
<onlinemapsource uid="701">
  <name>LIST Topographic Basemap</name>
  <url><![CDATA[https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Topographic/MapServer/tile/{$z}/${y}/${x}?.png]]></url>
  <website><![CDATA[<a href="https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Topographic/MapServer" target="_blank">LIST Topographic Basemap</a>]]></website>
  <minzoom>3</minzoom>
  <maxzoom>18</maxzoom>
  <projection>MERCATORESFERICA</projection>
  <servers/>
  <httpparam name=""/>
  <cacheable>1</cacheable>
  <downloadable>0</downloadable>
  <maxtilesday>0</maxtilesday>
  <maxthreads>0</maxthreads>
</onlinemapsource>
```
<xop></xop>
<yop></yop>
<zop></zop>
<qop></qop>
<sop></sop>
</onlinemapsource>
<onlinemapsource uid="702">
<name>LIST Orthophoto Basemap</name>
<url><![CDATA[https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/MapServer/tile/{$z}/{$y}/{$x}.png]]></url>
<website><![CDATA[<a href="https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Orthophoto/MapServer" target="_blank">LIST Orthophoto Basemap</a>]]></website>
<minzoom>6</minzoom>
<maxzoom>19</maxzoom>
</onlinemapsource>
<onlinemapsource uid="703">
<name>LIST Topographic Gray Scale Basemap</name>
<url><![CDATA[https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/TopographicGrayScale/MapServer/tile/{$z}/{$y}/{$x}.png]]></url>
<website><![CDATA[<a href="https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/TopographicGrayScale/MapServer" target="_blank">LIST Topographic Gray Scale Basemap</a>]]></website>
<minzoom>6</minzoom>
<maxzoom>19</maxzoom>
</onlinemapsource>
By adding the above text to the xml file, you will have access to the LIST’s Topographic, Topographic Grey Scale, Orthophoto and Scanned TASMAP basemaps. Save the file then copy and paste it back into your mobile device under …oruxmaps>mapfiles<.

Open OruxMaps and zoom into Tasmania, then click the **Switch Map icon** button in the top right of the screen.
• Then select the **Switch Map** icon from the drop-down menu.

• Choose a basemap from the list.
• If the text was copied correctly, the LIST basemap should now be displayed in OruxMaps

Adding WMS services to OruxMaps

If you are wanting to load the LIST basemaps, please use the method defined under Adding REST Tile Services to OruxMaps. By adding a WMS service in OruxMaps you may notice performance issues.
• Open OruxMaps then zoom into Tasmania, then press the **Switch Map icon** button in the top right of the screen. Please note that you will need to zoom in further than the extent of Tasmania, as some layers have zoom dependencies and may not show at this extent.

• Then select the **Switch Map** icon from the drop-down menu.
• In the top right-hand corner, click on the white Circle + symbol.

• Under ADD NEW MAPS, click on WMS (ONLINE) and the white + (PLUS) symbol.

• Type in a valid URL for example: https://services.thelist.tas.gov.au/arcgis/services/Public/CadastreAndAdministrative/MapServer/WMSServer, or check LIST ArcGIS Server for other services that support WMS capabilities (look for WMS in the top left corner).
• Then click the **OK** button top-right of screen to select specific layers.

[Image of screen showing a toolbar and list of layers]

• Select a layer from the available list then click **ACCEPT**.

[Image of screen showing a list of layers with some checked]
- Enter in a Zoom level such as 12. Click the **TEST** button to test the layer, if 12 does not bring up a test image, try higher zoom levels to zoom in a bit further. After successfully testing the service, specify the required zoom levels (6 and 18 is enough to cover Tasmania) then type in a meaningful name and click the **white tick icon** to create the WMS.

- To add the WMS service, simply select the newly created layer from the WMS folder.
• If the layer does not show up within a couple of minutes, you may need to zoom in a little closer to view the data.

[Image]

• An alternate way to add WMS services is to edit the `wms_services.xml` file located in `...oruxmaps\mapfiles` on the mobile device. To find the exact location, first open the OruxMaps application on your device, then click the Maps button in the top right, then Maps settings … the exact location can be found under the Maps directory section.

• Simply connect the mobile device to a computer, copy the file from `...oruxmaps\mapfiles` and paste it somewhere on the computer. Open the file in a text editor such as notepad++ or notepad and add the following code between the `<wms>` and `</wms>` tags, making sure that you do not delete any existing text. Be sure to include all the text below noting that it continues over two pages.
<wms>
  <name>LST Orthophoto</name>
  <uid>751</uid>
  <desc>LST Orthophoto</desc>
  <minzoomlevel>6</minzoomlevel>
  <maxzoomlevel>19</maxzoomlevel>
  <format>image/png</format>
  <coordinatesystem>EPSG:4326</coordinatesystem>
  <version>1.1.1</version>
</wms>

<wms>
  <name>LST Topographic</name>
  <uid>752</uid>
  <desc>LST Topographic</desc>
  <minzoomlevel>3</minzoomlevel>
  <maxzoomlevel>18</maxzoomlevel>
  <format>image/png</format>
  <coordinatesystem>EPSG:4326</coordinatesystem>
  <version>1.1.1</version>
</wms>

<wms>
  <name>LST Topographic Gray Scale</name>
  <uid>753</uid>
  <desc>LST Topographic Gray Scale</desc>
  <minzoomlevel>3</minzoomlevel>
  <maxzoomlevel>18</maxzoomlevel>
  <format>image/png</format>
  <coordinatesystem>EPSG:4326</coordinatesystem>
  <version>1.1.1</version>
</wms>

<wms>
  <name>LST Scanned TASMAP</name>
  <uid>754</uid>
  <desc>LST Scanned TASMAP</desc>
  <minzoomlevel>6</minzoomlevel>
  <maxzoomlevel>16</maxzoomlevel>
  <format>image/png</format>
  <coordinatesystem>EPSG:4326</coordinatesystem>
  <version>1.1.1</version>
</wms>
• The above code will add the basemaps as a WMS service. For performance reasons, it is recommended to use the REST tile services when consuming the basemaps, as detailed in Adding REST Tile Services to OruxMaps. By editing the above examples, you can add any of the LIST’s WMS services in this manner. Save the file, then copy and paste it back into the mobile device under ...oruxmaps\mapfiles. To add the WMS (if the code was entered correctly), select the Switch Map icon within OruxMaps.

• Under the WMS folder choose one of the newly added services from the list.
How to add services in Map Plus (mobile application for Apple iOS)

Adding WMS services to Map Plus

- Open Map Plus then zoom into Tasmania and press the **More options (3 dots) icon** button at bottom right of screen.

- Select the **Add (+) icon** from the side-bar menu.
• Select **Add Online Map** ... icon from the side-bar menu.

• Select **Manually Create** from the **Add Online Map via** ... pop-up menu.
• Enter a meaningful name for the Online Map (e.g. LISTmap Topographic Basemap).

• Scroll down the side-bar menu to find and select the **URL Pattern** option.
- Enter a valid WMS URL Pattern, e.g. https://services.thelist.tas.gov.au/arcgis/services/Basemaps/Topographic/MapServer/WmsServer?version=1.3.0&service=WMS&request=GetMap&LAYERS=0&STYLES=default&CRS=EPSG:3857&BBOX={$bbox_3857}&WIDTH=256&HEIGHT=256&FORMAT=image/png

and select Save.

Alternately, check **LIST ArcGIS Server** for other services that support WMS capabilities (look for WMS in the top left corner) and replace the text highlighted in yellow above accordingly.

- Refer to the **Map Plus online manual** for more help with URL patterns.
• Next select **Show On Map** from the pop-up menu.

![Show On Map](image)

• Finally click on the **Select** icon from the side-bar menu to display the map.

![Select Icon](image)
How to add services in MotionX-GPS (mobile application for Apple iOS)

Adding REST tile services (basemaps) to MotionX-GPS

- After installing the MotionX-GPS application on your Apple mobile device, open the application and click on the Menu button at the bottom right of the screen.

- Then click on the Setup button.
Under **Custom Maps**, select **New**.

- Type in a valid name for the service you want to add (in this example the **LIST’s Topographic Basemap**) and then a valid URL, for example: https://services.thelist.tas.gov.au/arcgis/rest/services/Basemaps/Topographic/MapServer/tile/[Z]/[Y]/[X].png
- To enable local caching for offline use, change the **Download map for offline use** setting to ‘**ON**’ and ignore any warnings.
• To set the new basemap in the application, select Maps, then under the Custom map catalog, select the new basemap service.

How to add services to AutoCAD Civil 3D 2015

Adding ArcGIS REST services to AutoCAD Civil 3D

Download and install AutoCAD service packs and ArcGIS for AutoCAD plugin

• Download and install the most current Service Packs for AutoCAD Civil 3D and AutoCAD Map 3D from https://knowledge.autodesk.com/support.

• Download and install the ArcGIS for AutoCAD plugin from https://www.esri.com/software/arcgis/arcgis-for-autocad/download

IMPORTANT NOTE: At time of writing this guide, a software bug has been detected in the ArcGIS for AutoCAD 350 software which results in REST Image Services not re-projecting in the coordinate system defined by the user. As a result, the Basemap Image Services are currently not available. A workaround exists for the Orthophoto and Topographic Basemaps by inserting them as a REST Map Service using following steps.

Setting drawing limits prior to adding services

• The ArcGIS for AutoCAD installation will add a shortcut to your Start menu called ArcGIS for AutoCAD 350. Select this shortcut to begin your AutoCAD Civil 3D session.
• A security concern warning may be displayed, as AutoCAD does not automatically trust the recently installed ArcGIS for AutoCAD dll file. Click the **Load** button.

![Security Concern Warning]

• As the service extents of some services cover the mainland of Australia, it is recommended that the zoom limits of your AutoCAD drawing file are restricted to the zoom level of Tasmania prior to adding services.

• Type **LIMTS** into the command line and click **Enter**.

• Type **204000,5160000** into the command line and click **Enter** (coordinates are in GDA 1994 MGA Zone 55).

• Type **660000,5640000** into the command line and click **Enter** (coordinates are in GDA 1994 MGA Zone 55).

• Type **LIMTS** into the command line and click **Enter**.

• Type **ON** into the command line and click **Enter**.

The settings applied will enable the user to enter the command **ZL** (Zoom Limits) into the command line to display at the zoom level of Tasmania.

*Adding ArcGIS REST services using ArcGIS for AutoCAD plugin*

• Select the **ArcGIS** ribbon and click the **Add Service** button.
• A warning will be displayed to indicate that a coordinate system has not been defined. Click the **Assign** button.

![Warning No Coordinate System Defined](image)

• **Select** a coordinate system from the available options (e.g. GDA 1994 MGA Zone 55). Click the **Open** button. ArcGIS for AutoCAD uses the selected coordinate system to project ArcGIS web services on the fly in AutoCAD.

![Open Coordinate System Source](image)

• Click the **New Server Connection** button.
• In the **Server URL** text box, type in a valid URL such as [https://services.thelist.tas.gov.au/arcgis/rest/services](https://services.thelist.tas.gov.au/arcgis/rest/services), and hit the **Tab** key. Leave the User Name and Password text boxes blank and click the **Next** button.

![Specify Server Connection Information](image)

• Expand the folders in the **Select a GIS Service** dialog box to see the available services. Expand the categories to see the available layers within each service. Select the layers to add to the drawing by clicking in the **Check Box** adjacent to each layer name.

• Select the **Service** (e.g. Planning Online) and then to **Set bounding box from**: select **Drawing Limits** from the drop-down list. Click the **Add** button followed by the **Close** button.

![Select a GIS Service](image)

• Type **ZL** (Zoom Limits) into the command line. The service is now displayed at the zoom level of Tasmania.
NOTE: The zoom level visibility and colour properties of each layer is defined by the service and cannot be modified. Additional zooming will be required to view some layers, and depending on the AutoCAD background colour, some layers may be difficult to view (e.g. cadastral boundaries are set to display as black). When panning, and zooming, services may take several seconds to refresh, depending on internet connection speeds.

- Layers within each service can be toggled on and off using the check boxes within the GIS Contents dialog box.

Adding WMS services to AutoCAD Civil 3D

For better performance, it is recommended to use ArcGIS REST services rather than WMS. Please see Adding ArcGIS REST services to AutoCAD Civil 3D for more details.

Fix for dialog window display issue in AutoCAD Civil 3D 2015

An issue exists in AutoCAD Civil3D 2015 where dialog windows are not displayed when executing some AutoCAD Map 3D commands. The following process will permanently correct this issue for future AutoCAD Civil 3D sessions.

- Within AutoCAD type the command OP into the command line, and click Enter (Options dialog box is opened).
• Select the **Files** tab and expand the **Support File Search Path** section.

• Click the **Add…** button and add the path: `C:\Program Files\autodesk\autocad 2015\map\support\en-us`  

• Click the **Apply** button, followed by the **OK** button.

• **Restart AutoCAD Civil 3D** (a restart is required for changes to take effect).

---

**Assigning a global coordinate system to your AutoCAD Drawing**

In order to add WMS services to AutoCAD in a consistent coordinate system, it is recommended that a Global Coordinate System is assigned to your AutoCAD Drawing prior to adding any services. (NOTE: If a coordinate system is not defined by the user prior to adding WMS services, the coordinate system of the first service added will be assigned to the Drawing automatically).

• Within AutoCAD, type the command **MAPWSpace** into the command line, and click **Enter**. Click **Enter** again to select the **On** option and activate the Task Pane.
• Select the **Map Explorer** tab on the **Task Pane**.

![Map Explorer Task Pane](image1)

• Right-click on the **Current Drawing** text and select **Coordinate System**...

![Coordinate System dropdown](image2)

• Click the **Select Coordinate System**... button.

![Select Coordinate System dialog](image3)
• In the **Search text box** type in the name of the desired coordinate system (e.g. MGA). Click on the chosen coordinate system name (e.g. MGA-55) and click the **Select** button.

• Click the **OK** button to assign the global coordinate system.
Adding WMS services to AutoCAD Drawing

- In the Task Pane, select the Display Manager tab, click the Data button and select Connect to Data…

- In the Data Connections by Provider list, select Add WMS Connection. In the URL box, type in a valid URL, such as:

![Image of Display Manager tab with Connect to Data option selected.](image)

- In the Data Connections by Provider list, select Add WMS Connection. In the URL box, type in a valid URL, such as:

  https://services.thelist.tas.gov.au/arcgis/services/Public/TopographyAndRelief/MapServer/WMSServer

- Click the Connect button.

  Please refer to LIST ArcGIS Server for services that support WMS capabilities (look for WMS in the top left corner)
• Leave the User Name and Password fields blank and click the **Login** button.

![Login button](image)

• Select the layers to be added to your Drawing by clicking in the **Check Box** to the left of each layer name. Note that the previously set Global Coordinate System (referred to as Map Coordinate System) is listed near the bottom of the Data Connect dialog box.

![Data Connect dialog box](image)

• Click the **Add to Map** button.
References for spatial applications

- **ArcMap 10.6** (Google Search)
- **ArcGIS Pro 2.4** (Google Search)
- **ArcGIS Online** (Google Search)
- **QGIS 3.8.3** (Google Search)
- **MapInfo Pro v2019** (Google Search)
- **Map Plus** (Google Search)
- **MotionX-GPS** (Google Search)
- **AutoCAD Civil 3D 2015** (Google Search)

Feedback and further support

**LIST Helpdesk**

If you have any feedback to offer on LISTmap or this document, feel free to contact our helpful Client Services team by:

- **Phone:** (03) 6165 4444 or
- **Email:** listhelp@dpipwe.tas.gov.au